Using Geocoded TIFF & JPEG Files
in ER Mapper 6.3 with SP1

Eric Augenstein
Earthstar Geographics
Web: www.es-geo.com

1

Using Geocoded TIFF and JPEG Files in ER Mapper 6.3 with SP1

Table of Contents
WHAT IS NEW IN 6.3 SP1 REGARDING WORLD FILES? ......................................................................................3
WHAT IS GEOTIFF FORMAT? .....................................................................................................................................3
WHAT IS TIFF, JPEG OR BMP WITH WORLD FILES FORMAT?........................................................................4
WHAT INFORMATION IS IN A WORLD FILE? ........................................................................................................4
WHAT INFORMATION IS NOT IN A WORLD FILE? ..............................................................................................5
OPENING TIFF, JPEG OR BMP IMAGES IN ER MAPPER .....................................................................................5
GENERATING ERS HEADERS FOR TIFF, JPEG OR BMP IMAGES ....................................................................6
METERS VS. FEET IN ER MAPPER.............................................................................................................................7
DO I STILL NEED ERS FILES FOR METER-BASED IMAGES?.............................................................................9
WHAT IF I HAVE GEOTIFFS WITH WORLD FILES? ...........................................................................................10
EXPORTING IMAGES WITH WORLD FILES IN ER MAPPER............................................................................10
HOW ER MAPPER HANDLES ROTATION IN WORLD FILE IMAGES .............................................................11

2

Using Geocoded TIFF and JPEG Files in ER Mapper 6.3 with SP1

This document describes how to use geocoded (or georeferenced) TIFF, JPEG and
BMP files in ER Mapper 6.3 with Service Pack 1 (SP1) installed. It is intended
primarily for those using ER Mapper to mosaic airphotos or scanned topo maps, but
the general concepts apply to any images stored in these formats.
Use this document as a reference if you are trying to use the following file types in
ER Mapper:
■

GeoTIFF files

■

TIFF with world (.tfw) files

■

JPEG with world (.jgw, .jpegw, or .jpw) files

■

BMP with world (.bpw) files

What is new in 6.3 SP1 regarding World files?
ER Mapper 6.3 with Service Pack 1 (SP1) introduced two new capabilities that
improve the way it handles World files:
■

■

Rotation parameters are now read automatically when you open an image with a
World file. See the section “How ER Mapper handles rotation in World file
images” for details.
The Save As dialog boxes for TIFF/GeoTIFF, JPEG, BMP and BIL/HDR formats
now have an option to generate a World file when exporting images. See the
section “Exporting images with World files in ER Mapper” for details.

What is GeoTIFF format?
GeoTIFF is a type of TIFF (Tagged Image File Format) graphics file that contains
georeferencing information embedded as “tags” in the TIFF file’s header section.
This includes the datum, map projection, pixel size, registration coordinate, and
other information needed to properly georeference the image when opened in
applications like ER Mapper that understand the tags.
Using GeoTIFF files in ER Mapper is easy–just open the file(s) and go. ER Mapper
reads the GeoTIFF tags and uses the georeferencing information automatically. It is

3

Using Geocoded TIFF and JPEG Files in ER Mapper 6.3 with SP1

sometimes not easy to tell whether a file is a GeoTIFF or a plain TIFF just by the
filename. See the section “What if I have GeoTIFFs with World files?” for details.

What is TIFF, JPEG or BMP with World files format?
TIFF, JPEG and BMP are three generic graphics file formats in which images such as
airphotos, scanned maps, and so on are commonly stored. Most applications can
read these files, so they are commonly used for storage and delivery of image data.
Many times TIFF, JPEG and BMP files are accompanied by a “world” file that
provides basic georeferencing information (but not all information) about the image
file. ER Mapper recognizes files with the following extensions as World files:
■

.tfw (when accompanied by a .tif file)

■

.jgw, .jpegw or .jpw (when accompanied by a .jpg file)

■

.bpw (when accompanied by a .bmp file)

The world file provides basic (but not complete) georeferencing information that
allows “geographically-aware” software products like ER Mapper to position the
image file in a coordinate system relative to other images or vector data. (The World
header file format was developed by ESRI for use in their GIS products such as
ArcView©, but it is commonly used by many other geographic software products
and data vendors.)

What information is in a World file?
A World file is a simple ASCII text file that contains the X and Y pixel size, the
rotation, and the registration coordinate of the center of the upper-left corner pixel in
the image. Following is a sample World file (descriptions have been added ins are in
parentheses):
5.25000 (X pixel size)
0.0
(Rotation term for row)
0.0
(Rotation term for column)
-5.25000 (Y pixel size, negated to represent upper-left of image)
6270000.00000 (X coordinate of center of upper-left pixel)
18262000.00000 (Y coordinate of center of upper-left pixel)
The pixel size and registration coordinates are expressed in units such as meters,
feet, or decimal degrees. (The Y pixel size is usually a negative value to account for
the differences between the origin of image and non-image data in ESRI products.
Most other products simply ignore the negative sign when reading the data.)
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Note: ER Mapper 6.3 with SP1 now reads and uses the rotation parameters in World
files. This means that images with rotation will now display with proper coordinates
when the projection information is defined to ER Mapper (see below).

What information is not in a World file?
Unfortunately World files do not contain some georeferencing information that is
required to properly georeference the TIFF, JPEG or BMP image file in ER Mapper .
These include:
■

■

■

Geodetic Datum–A spheroid and tie point, this defines the local variation in the
shape of the earth's surface in that area of the world. (Common datums used in
the USA include NAD27 and NAD83. Each part of the world has it’s own
datums used locally.)
Map Projection–The model used to translate spherical earth coordinates onto a
flat 2-D surface (the map). Common projections include Universal Transverse
Mercator (UTM), Transverse Mercator, Lambert Conformal Conic, and many
others. (US State Plane map projections are either Tranverse Mercator or
Lambert Conformal Conic depending on the state, but are often referenced
simply by name such as “California State Plane Zone 6.”)
Units–The measurement units used for coordinates in the selected map
projection. Most projections such as UTM use meters, but US State Plane
projections usually (but not always) use feet. Units of decimal degrees are also
used for generic Latitude Longitude projections sometimes called “geographic”
(the “Geodetic” projection in ER Mapper).

Since this information is not contained in the World file, it must be added by the user
to ensure that the TIFF or JPEG images are georeferenced properly in ER Mapper
and that any subsequent processing and output to GeoTIFF, ECW, etc. will be
correct. (This is explained in the following sections of this guide.) To get the datum,
projection and units information, you may need to contact the person who provided
the TIFF, JPEG or BMP files, so be sure to ask for it.

Opening TIFF, JPEG or BMP images in ER Mapper
ER Mapper 6.3 can directly read the TIFF, JPEG and BMP formats, so you simply
need to select File/Open to load and display the image. If a World file with the same
base filename is present in the same directory as the TIFF, JPEG and BMP file,
ER Mapper will automatically transfer the pixel size, rotation, and upper-left
coordinate information when it displays the image. (If the file is a GeoTIFF, that
information overrides information in the World file.) This also goes for mosaicking
multiple TIFF, JPEG or BMP images using ER Mapper’s Image Display and Mosaic
Wizard.
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As mentioned previously, you can display TIFF, JPEG and BMP images and often
mosaic them successfully without entering the undefined datum, projection and
units information. If you are simply “making pictures” this is OK, but if you want to
create truly georeferenced image products or export results to a format like GeoTIFF
or ECW, you must enter the undefined projection information.

Generating ERS headers for TIFF, JPEG or BMP images
Doing this is easy. Simply run ER Mapper’s “Change Projection/Datum/Cell Size”
wizard. This will create ERS header files with the correct datum and projection to
accompany the image and World files. It can be run in batch to process all files in a
directory, or a single file. Follow these steps to perform this procedure:
1.

Click the Change Projection/Datum/Cell Size for many images
button on
the ESG Utilities toolbar. (If the toolbar is not displayed, select Batch Processing
from the Toolbars menu.)

2.

On the “Select one of the input images to change” page, load one of your TIFF,
JPEG or BMP files. Then select the appropriate option to process one image or
all images in the directory.

Select an
image

Process
only one
or all
images

3.

Click Next>. One the “Select Datum/Projection/Cell Size changes to make”
page, select the correct datum and map projection. If your input images are in a
meter-based projection (UTM, etc.), select “Do not change” for Cell Size. If your
images are in foot-based projection (such as some U.S. State Plane), select
“Convert to meters.” (This is very important. See “Meters vs. Feet in
ER Mapper” later for an explanation as why you need to do this.)
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Select correct
datum and
projection

‘Do not
change’ for
meters, or
‘Convert to
meters’ for
images in
feet

Note: If you need help selecting the appropriate ER Mapper projection for US State
Plane projections, go to ER Mapper’s Help->User Guide->Appendices->Supported
Map Projections and Datums for a list.
4.

Click Next> to show the proposed changes. Verify, then click Next> to start the
processing. When finished, you will now have a set ERS headers files in the
same directory as your image and world files. Use these files from now on when
opening or mosaicking images in ER Mapper.

Meters vs. Feet in ER Mapper
This section describes how ER Mapper handles coordinate units (meters or feet)
when using TIFF, JPEG and BMP files with World files. This is especially important for
those using foot-based map projections such as many of the U.S. State Plane projections.
ER Mapper always internally stores the cell (pixel) sizes of images in meters. (The
only exception is for images in the Geodetic projection, which uses decimal degrees.)
This is not a problem, but issues can arise when you are not aware of this.
When you open a TIFF, JPEG or BMP image with a World file in ER Mapper, it
internally reads the registration coordinate and cell size from the World file, and sets
a default datum of “WGS84” and default projection of “LOCAL.” This is because
World files do not contain datum or projection information. (LOCAL tells
ER Mapper that the image is projected, but in an unknown coordinate system.)
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Default
datum and
projection
for images
with World
files

Cell sizes read
from World file
(assumed
meters since
projection is
unknown)

This means that if the cell size stored in your World file is in feet, then you need to
convert those values to their meter-equivalent values. (If your cell sizes in the World
files are in meters, such as for a UTM meters projection, then you don’t need to
convert them.)
This is the reason for selecting the “Convert to meters” setting when generating your
ERS headers in the previous section. This lets ER Mapper correctly interpret the cell
sizes in relation to the registration coordinates of the image (which were feet in the
World files and remain feet in ER Mapper.) So, after generating an ERS header for
the image above (in Arizona State Plane Central in feet), the updated image
information now looks like this:

Correct
datum and
projection

Cell sizes
converted from
1.275 feet to
meter
equivalent
values

Now you are ready to proceed processing and mosaicking your images in
ER Mapper.
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Do I still need ERS files for meter-based images?
Yes! Even if your World file images are in a meter-based projection or geographic/
Lat Long projection, you should still run the “Change Projection/Datum/Cell Size”
wizard to generate ERS headers for them. Why? Because without knowing the
datum and projection, you can’t display Lat Long values for the images, add a Lat
Long grid in map composition, or export them to a GeoTIFF or ECW file so other
applications can also read the projection information.
For example, assume you have a TIFF, JPEG or BMP image in a UTM projection
(zone 11 north in this case). If you open the image in ER Mapper without creating an
ERS header, then select View->Geoposition->Extents, this is what you see:

Lat Long values cannot be calculated without knowing the projection

After generating the ERS header and redisplaying the image, this is what you see:

Correct Lat Long values now shown
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What if I have GeoTIFFs with World files?
Some data vendors will give you images in GeoTIFF format, but also supply a World
file in addition. The World file is redundant for products like ER Mapper because all
the needed information is contained in and read from the GeoTIFF (.tif) file.
However the fact that a World file is present may make you think the images are not
in GeoTIFF format, when in fact they might be. This can be very confusing!
To test whether a TIFF image is a GeoTIFF, use this procedure (before you generate an
ERS header). Open it in ER Mapper. Click the Load Dataset
main menu (2nd row), then click Info. Then:
■

■

■

button on the

If the datum is not RAW or WGS84 and the projection is not RAW or LOCAL,
you have a GeoTIFF file. Then you do not need to generate ERS headers at all,
just load and use the images as is.
If the datum is WGS84 and the projection is LOCAL, you have a plain TIFF
image with a World file. Although it is possible to use these images to some
extent as is, you should generate ERS headers with the correct datum and
projection to fully georeference them.
If the datum is RAW and the projection is RAW, you have a plain TIFF image
without a World file. This image is either not geocoded, or the geocoding
information is provided in a different format that ER Mapper cannot read
automatically. If the image is geocoded, you need to manually enter all the
information to create an ERS file using the Dataset Header Editor. If it is not
geocoded, you can use the Geocoding Wizard to rectify or orthorectify the
image.

Exporting images with World files in ER Mapper
ER Mapper 6.3 with SP1 adds the capability to automatically write World files when
exporting (saving as) images to TIFF/GeoTIFF, JPEG, BMP and BIL/HDR formats.
This can be nice when your clients are used to having World files for GeoTIFFs.
World files are also the easiest and most universal way to provide basic
georeferencing information for JPEG or BMP images.
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Check to write
World file
Note: The “Write world file” setting can be enabled/disabled in the Save As dialog
as shown above, or can be set as a product default setting using the
Edit->Preferences->General “Write world file on save” option.

How ER Mapper handles rotation in World file images
ER Mapper 6.3 with SP1 adds the capability to read and use the rotation parameters
in World files, and also to save them as part of World files when exporting images
(see “Exporting images with World files in ER Mapper”). The rotation parameters in
World files (the 2nd and 3rd fields) are actually X and Y translation parameters. When
ER Mapper opens an image with a World file, it automatically converts those
parameters into a single rotation value that it uses internally. This means that the
geographic locations show in ER Mapper will be true once the correct datum and
projection are defined. (ER Mapper expresses rotation as the number of degrees
rotated from north, which is just a different way than using X and Y translations).
To see whether an image with a World file is rotated from north, open it in
ER Mapper. Click the Load Dataset
button on the main menu (2nd row), then
click Info. If the Rotation value is not 0.00000, then the image has been rotated from
north according to the World file.
When exporting rotated images to formats that use World files (TIFF, JPEG, etc.),
ER Mapper converts it’s single rotation value back into the equivalent X and Y
translation parameters in the World file. This also means that the cell sizes in the
World files may be slightly different than those listed in ER Mapper. They are
adjusted as part of the translation, and this is normal.
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I hope all this has helped! Please contact me if you have any questions or find any
errors.
Eric Augenstein
Earthstar Geographics
Web: www.es-geo.com
Email: eric@es-geo.com
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